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Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

Thefollowing paragraph does not apply to the United Kingdom or any
other country where such provisionsareinconsistent with local law: IN-
TERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES
THISPUBLICATION “ASIS” WITHOUT WARRANTY OFANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MER-
CHANTABILITY OR FITNESSFOR A PARTICULAR PURPOSE. Some
states do not alow disclaimer of express or implied warrantiesin certain
transactions. Therefore, this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical er-
rors. Changes are periodically made to theinformation herein; these changes
will be incorporated in new editions of the publication. IBM may make im-
provements and/or changesin the product(s) and/or the program(s) described
in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sitesis at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the pur-
pose of enabling: (i) the exchange of information between independently cre-
ated programsand other programs (including thisone) and (ii) the mutual use
of the information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

1 Rogers Street

Cambridge, Massachusetts 02142

USA.

Such information may be available, subject to appropriate terms and condi-
tions, including in some cases, payment of afee.
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The licensed program described in this document and all licensed material
availablefor it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement or any equiva
lent agreement between us.

Any performance data contained herein was determined in a controlled envi-
ronment. Therefore, the results obtained in other operating environments
may vary significantly. Some measurements may have been made on devel-
opment-level systemsand thereisno guarantee that these measurementswill
be the same on generally available systems. Furthermore, some measure-
ments may have been estimated through extrapolation. Actual results may
vary. Users of this document should verify the applicable data for their spe-
cific environment.

Information concerning non-IBM products was obtained from the suppliers
of those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM prod-
ucts. Questions on the capabilities of non-IBM products should be addressed
to the suppliers of those products.

This information contains examples of data and reports used in daily busi-
ness operations. To illustrate them as completely as possible, the examples
include the names of individuals, companies, brands, and products. All of
these names arefictitious and any similarity to the names and addresses used
by an actual business enterpriseis entirely coincidental.

If you are viewing thisinformation softcopy, the photographsand color illus-
trations may not appear.

Additional legal notices are described in thelegal_information.html file that
isincluded in your software installation.

Copyright license

This information contains sample application programs in source language,
which illustrate programming techniques on various operating platforms.

Y ou may copy, modify, and distribute these sample programs in any form
without payment to IBM, for the purposes of developing, using, marketing
or distributing application programs conforming to the application program-
ming interface for the operating platform for which the sasmple programs are
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written. These examples have not been thoroughly tested under all condi-
tions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs.

Each copy or any portion of these sample programs or any derivative work,
must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM
Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years .

Trademarks

IBM, the|BM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions

worldwide. Other product and service names might be trademarks of IBM or
other companies. A current list of IBM trademarksisavailable on the Web at

www.ibm.com/legal/copytrade.html

Adobe, the Adobe logo, PostScript, and the PostScript logo are either regis-
tered trademarks or trademarks of Adobe SystemsIncorporated inthe United
States, and/or other countries.

IT Infrastructure Library is aregistered trademark of the Central Computer
and Telecommunications Agency which is now part of the Office of Govern-
ment Commerce

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino
logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trade-
marks or registered trademarks of Intel Corporation or its subsidiariesin the
United States and other countries.

Linux isaregistered trademark of Linus Torvaldsin the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks
of Microsoft Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the
Office of Government Commerce, and isregistered in the U.S. Patent and
Trademark Office

UNIX isaregistered trademark of The Open Group in the United States and
other countries.
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Javaand al Java-based trademarks and logos are trademarks of Sun Micro-
systems, Inc. in the United States, other countries, or both.

Other company, product or service names may be trademarks or service
marks of others.
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Contacting IBM Rational Software Support

If the self-hel p resources have not provided aresolution to your problem, you
can contact IBM® Rational® Software Support for assistance in resolving
product issues.

April 2010

Prerequisites

To submit your problem to IBM Rational Software Support, you must have
an active Passport Advantage® software maintenance agreement. Passport
Advantageisthe IBM comprehensive software licensing and software main-
tenance (product upgrades and technical support) offering. Y ou can enroll
online in Passport Advantage from |http://www.ibm.com/soft-
ware/lotus/passportadvantage/howtoenroll.htm

To learn more about Passport Advantage, visit the Passport Advantage
FAQs at http://www.ibm.com/software/l otus/passportadvan-
tage/brochures_fags quickguides.html.

For further assistance, contact your IBM representative.

To submit your problem online (from theIBM Web site) to IBM Rational
Software Support, you must additionally:

Bearegistered user onthe | BM Rational Software Support Web site. For
details about registering, go to http://www.ibm.com/software/support/.

Belisted as an authorized caller in the service request tool.
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Submitting problems

To submit your problem to IBM Rationa Software Support:

1. Determine the business impact of your problem. When you report a
problem to IBM, you are asked to supply aseverity level. Therefore, you
need to understand and assess the business impact of the problem that

you are reporting.

Use the following table to determine the severity level

Severity

Description

1

The problem has a critical business impact:

Y ou are unableto use the program, resulting in
acritical impact on operations. This condition
requires an immediate solution.

Thisproblem hasasignificant businessimpact:
The program is usable, but it is severely lim-
ited.

The problem has some business impact: The
program is usable, but less significant features
(not critical to operations) are unavailable.

The problem hasminimal businessimpact: The
problem causes little impact on operationsor a
reasonabl e circumvention to the problem was
implemented
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2. Describe your problem and gather background information, When de-
scribing aproblemto IBM, be as specific as possible. Includeall relevant
background information so that IBM Rational Software Support special-
ists can help you solve the problem efficiently. To save time, know the
answers to these questions:

— What software versions were you running when the problem oc-
curred?

To determine the exact product name and version, use the option appli-
cableto you:

— Startthe IBM Installation Manager and select File> View I nstalled
Packages. Expand a package group and select a package to see the
package name and version number.

Start your product, and click Help > About to see the offering name and
version number.

— What isyour operating system and version number (including any
service packs or patches)?

— Doyou havelogs, traces, and messages that are related to the
problem symptoms?

— Can you recreate the problem? |f so, what steps do you perform to
recreate the problem?

— Didyou makeany changesto the system? For example, did you make
changesto the hardware, operating system, networking software, or
other system components?

— Areyou currently using aworkaround for the problem? If so, be pre-
pared to describe the workaround when you report the problem.
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3. Submityour problemto IBM Rational Software Support. Y ou can submit
your problem to IBM Rational Software Support in the following ways:

Online: Go to the IBM Rational Software Support Web site at
https.//www.ibm.com/software/rational/support/ and in the Rational
support task navigator, click Open Service Request. Select the elec-
tronic problem reporting tool, and open a Problem Management
Record (PMR), describing the problem accurately in your own
words.

For more information about opening a service request, go to
http://www.ibm.com/software/support/hel p.html

Y ou can also open an online service request using the IBM Support
Assistant. For more information, go to http://www.ibm.com/soft-
ware/support/isa/fag.html.

By phone: For the phone number to call in your country or region, go
to the IBM directory of worldwide contacts at
http://www.ibm.com/planetwide/ and click the name of your country
or geographic region.

Through your IBM Representative: If you cannot access IBM Ra-
tional Software Support online or by phone, contact your IBM Rep-
resentative. If necessary, your IBM Representative can openaservice
request for you. Y ou can find complete contact information for each
country at http://www.ibm.com/planetwide/.

If the problem you submit isfor asoftware defect or for missing or inaccurate
documentation, IBM Rational Software Support creates an Authorized Pro-
gram Analysis Report (APAR). The APAR describes the problem in detail.
Whenever possible, IBM Rational Software Support provides aworkaround
that you can implement until the APAR isresolved and afix is delivered.
IBM publishesresolved APARson the IBM Rational Software Support Web
sitedaily, so that other users who experience the same problem can benefit
from the same resolution.
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Chapter 2: Rational Systems Tester TRI Integration

Introduction

Note

Purpose of this tutorial

Thistutorial aims at giving the reader a hands-on experience on what is re-
quired from TRI integration and how to properly implement one. Y ou are ex-
pected to know TTCN-3 to be able to follow the tutorial as well as having
read Rational Systems Tester “ Technical Integration Documentation” (PDF-
file found on distribution CD) and the TRI Specification.

The tutoria will try to answer the following questions:

*  WhatisaTRI integration? Why is it necessary and how do | implement
it?
» Howdol create alog and plug it into the executabl e test suite?

» How do | develop and add encoding and decoding functions? Why isit
necessary?

e How do | build a complete executable test suite and how do | run it?

The tutorial implementation and this tutorial are made for the Windows
platform. It should be easy however, for a skilled programmer to adopt the
instructions and modify the implementation for a Unix or other non-Win-
dows platform.
Terminology
Often used termsin this tutorial that you should be familiar with:
ATS Abstract Test Suite
ETS Executable Test Suite
Compiler Rationa Systems Tester TTCN-3 Com-
piler
MTC Master Test Component
PTC Parallel Test Component
RTS Run-Time System
SUT System Under Test
IBM Rational Systems Tester 3.3 TRI Integration Tutoria April 2010
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TRI TTCN-3 Run-time Interface

Files

In the text there will sometimes be referencesto the <tutorial dirs direc-
tory. Thisisthe example directory that will reside in your installation, typi-
cally for Windows this would be:

[Tester Installation Directory]\examples\ttcn3tutorial
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System overview

Goal

After thispart you should understand the layout of thetest system, the system
under test (SUT), the code modules involved and how they relate to each
other.

Abstract Test Suite and System Under Test

An Abstract Test Suite (ATS) isgenerally developed with the System Under
Test in mind. The SUT has a number of potential communication channels
(ports) through which dataistransferred (aprotocol). Inthis casethe SUT is
a separately running process which communicates through a socket. Before
the tests are performed the communication is set up between the Executable
Test Suite (ETS) and the SUT.

socket

Figure 1: ETSand SUT processes

The ATSiswrittenin TTCN-3 and as always, to be able to compile and link
the TTCN-3 code into an executable, an integration (or adaptation) needsto
be implemented. In thistutorial, the integration is written according to the
TRI specification. Theintegration is required to handle the ports of the ATS,
their mappingsto TSI (Test System Interface) ports and the communication
of datato the SUT over the socket.
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ATS

| |

TesterTutorial.ticn  |wimport TT.iten TesterTutorial.asn

< ‘

testertutorial_TRl.c

w0

2

=

o tut_ports.c tut_comm.c
z

© | TutorialModule.c

2

CaD: tut_codecs.c tut_log.c

ng

ETS

Figure2: ATSto ETS

The gray modulesin Figure 2 on page 5 are all part of the TRI integration
implementation. The light gray ones are not strictly defined by TRI but nev-
ertheless needed to compl ete the integration with encoding and decoding
functions (tut_codecs.c). Thelog mechanism (tut_log.c) iscompletely
optional but added to show its use. The modules will be explained in more
detail in the subsequent parts of this tutorial.
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The Abstract Test Suite

Note

Note

Note

Goal

In thispart you will create and insert filesinto a TTCN-3 Projectin IBM Ra-
tional Systems Tester. The analysistool will also be used on the newly cre-
ated project.

In IBM Rational Systems Tester thereis an option of creating template
projects from a set of predefined examples included with the tool installa-
tion, including the TTCN-3 tutorial example files. For the Rational Systems
Tester tutorial, it is not necessary to copy the supplied source files any-
where since they are not supposed to be edited as part of the tutorial. If you
choose to open a template project dialog and select the ttcn3tutorial, the
supplied fileswill be copied to a project folder of your choice. The project
and workspace files will be created from the actions described in this docu-
ment.

TTCN-3 Project creation

When running this Tutorial on Linux or Solaris platform ensure that
OSTYPE environment variableis set to “ linux” or “ solaris’ respectively
before you start IBM Rational Systems Tester.

Start IBM Rational Systems Tester. In the File menu choose New and create
anew TTCN Project and giveit a proper name and location. Keep the
Create new wor kspace choice selected.

Ensure that path to project does not contain spaces. ASN.1 compiler may
behave incorrectly when it’ sinvoked for files containing spacesin the path.

In the next dialog uncheck the Add TTCN-3 fileto the project and Add
adapter templatesto the project. The reason for thisisthat all the neces-
sary ATSfileswill be added later on. Click Next and then Finish to finalize
the project creation.

Now that you have yourself a new empty project it istimeto bring the ATS
filesinto the project.

IBM Rational Systems Tester 3.3 TRI Integration Tutoria April 2010



The Abstract Test Suite
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Add files to the project

In the Workspace view (the area on the left side), choose the File View by
clicking that tab at the bottom. Now you should seethe Tutorial.ttp project

appear.

Right-click on the project and choose New Folder. Create a folder named
ATS Files, intheFileextensionsfield enter: x.ttcn; *.asn

Right-click the new folder aTs riles folder and choose I nsert files. Add
the TesterTutorial.tten, TT.tten and TesterTutorial.asn files
fromthe <tutorial dirs directory. The Workspace should now look
likeFigure 3 on page 7.

==

- E Tutarial
= @ Tutorial_ttp
=1+l ATS Files
TT.thzn
@ TesterTutarial. azn
TesterT utorial then

‘| | B
BECAEETETEN

Figure 3: Workspace File View

Analyze the test suite files

Now all the ATS files have been added to the project. Save All by clicking
theicon on the tool bar or selecting the entry in the File menu. Finally click
the Analyze button (check box symbol) or the entry inthe Pr oj ect menu. The

IBM Rational Systems Tester 3.3 TRI Integration Tutorial 7
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analysis should go through without problems, warningsor errors. The default
settingsfor analysisare sufficient. Go to the Pr oj ect menu, open the Settings
dialog. The settings are found in TTCN-3 and ASN.1 tabs.
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Test behavior

Goal

This part shows the purpose of the test cases and what is communicated be-
tween the ETS and the SUT during test execution.

In the test suite there are three test cases, one using asynchronous communi-
cation only (Tc1a), one that uses synchronous communication (Tc2s) and
the last one (TcTimer) uses timers without any communication whatsoever.

Look at test case TCla

Open the Tester Tutorial.ttcn file and locate the test case definition named
TCla.

Thistest case requests the SUT to perform two operations on supplied oper-
ands. One operation is requested by the PTC and the second by the MTC.
Below is a picture that shows how the message sequence goes:

TCla
(in integer v)

PTC
(in integer v)

PTCONling
true
{"square’, v}

{{"square", vhvy

\“—ﬂ

L0 | —

{{ "equais”, 4:

S 51
frue PASS

SR

{ PASS )

Figure 4. Sequence diagram of TCla
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The picture showswhat happensin thistest case. A PTCiscreated to perform
arequest tothe SUT to calculatethe“square” operation on avalue, it verifies
the returned result and signalsto the MTC that it went fine and then it termi-
nates. After the M TC detectsthat the PTC operation isfinished it requeststhe
SUT to perform an equality operation on an integer value and a bit string
value and then the test is finished.

Look at test case TC2s

Open the Tester Tutorial.ttcn file and locate the test case definition named
TC2s.

Thistest caseis somewhat simpler but instead involves synchronous commu-
nication. Below is a picture that shows how the message sequence goes.

TC2s SUT

true

\—\_\—L

frue

\_\_\D

call{(SUTETSCall'00010001'B))

-t

reply(SUTETSCall value 17}

Y

call[ETSSUTCall('2A'H))

reply( ETSSUTCall value 42)

{ PASS

Figure 5: Sequence diagram of TC2s

The picture shows what happensin thistest case. The SUT initiatesacall to
the MTC which returns an integer value converted from the bit string argu-
ment. The same operation isthen donein the other direction with ahex string
value after which the test is finished.
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Look at test case TCTimer

Open the Tester Tutorial.ttcn file and locate the test case definition named
TCTimer. Thetest caseissimpleto explain without apicture. TheMTC starts
bothitstimers(T1 and T2) and waitsfor them to time out in the specific order
T1 followed by T2. This test sets the requirement for the timer implementa-
tion that it can handle multiple timers. M ore about the timer implementation
isexplained in “Integration implementation” on page 14.

IBM Rational Systems Tester 3.3 TRI Integration Tutorial 11
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Communication and Ports

Goal

This part shows the communication between the test and the SUT and the
role of the ports.

The SUT presents four ports through which communication can be per-
formed. They are called PO-P3. The SUT ports have different roles and pur-
poses. The port roles are described for each of the test cases.

Port mappings of TCla

OpentheTester Tutorial.ttcn fileand look at the port definitions of the com-
ponent type MyMTca on which test case Tcia runs. It has two ports;
MTC2TSIport and MTC2 PTCport.

MTC2PTCport

PTCBehave
(PTC)

TC1a
(MTC)

PTC2MTCport

MTC2TSIport PTC2TSIport

SUT

Figure 6: Port mappings of TCla

As can be seen in the component and port type declarations, the TSI port PO
isused by the MTC and the P1 port is used by the PTC.

12 IBM Rational Systems Tester 3.3 TRI Integration Tutorial April 2010



Communication and Ports

Port mappings of TC2s

Openthe Tester Tutorial.ttcn fileand look at the port definitions of the com-
ponent type MyMTCs on which test case Tc2s runs. It has three ports:
MPortIn, MPortoutand MPortInit.

MPaortinit MPortOut

SUT

Figure 7: Port mappings of TC2s

TheMPortInit-Po port mapping isused for asynchronousinitialization sig-
naling and the MPortIn-P2 and MPortout - P3 Mappings areisused for syn-
chronous communication.

April 2010 IBM Rational Systems Tester 3.3 TRI Integration Tutorial 13
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Integration implementation

Goal

This part shows what is required from a TRI integration implementation,
which functions need to be implemented and how. After this part you will
have built a TTCN-3 Project with both ATS files and the necessary TRI
based integration.

Code modules

The implementation code is divided into five different code modules (with
separate C header files):

e testertutorial tri.c
Thisis the main integration file which implements the necessary TRI
functions. The next step covers the functionsin thisfile.

e tut_comm.c
This contains the helper functions for composing and decomposing the
information sent between the ETS and the SUT over the socket.

e tut_ports.c
This contains the representation and helper functions for port mappings.

e tut_codecs.c
This contains the required encoding and decoding functions for the used
types. Thereisonly codecs support for the built-in TTCN-3 typesusedin
thetest suite; boolean, integer, bitstring and hexstring. Notethat
the ASN. 1 types aready have the codecs set for them, automatically gen-
erated by the Compiler.

e tut log.c
Thisis contains the log mechanism developed for the tutorial. It is cov-
ered in “Runthe ETS’ on page 21.

Add the integration files to the project

Make sure you havethe File View tab activein the Wor kspace view. Right-
click on the project and choose New Folder. Create afolder named
Integration Files, intheFileextensionsfield enter: *.c; *.n

14 IBM Rational Systems Tester 3.3 TRI Integration Tutorial April 2010



Integration implementation

Right-click the new 1ntegration Files folder and chooseInsert files.
Add the Cfileslisted above from the <tutorial dirs except tut log.c,
together with their respective header files. tut_log.c file, containing the
new log mechanism, will be added in the next part. Note that the
testertutorial tri.c file hasno header file. The project should now
look something like below, the order of the files are not important:

1=

= E Tutarial the

- Tutorial_ttp
=) ATS Filez
TT.thzn
|E| TesterTutarial. azn
TesterTutornial thcn
=13 Integration Files
1 testertutorial_ti.c
1 tut_codecs.c
1 tut_caomm.c
tut_comm.h
1 tut_parts.c
tut_portz.h

<| | b

e EETETEN

Figure 8: Workspace TRI file view.

In-depth look at TRI TE-SA functions

Now it'stimeto look at the TRI integration of thistutorial. There are a
number of functions that needs to be implemented and they are covered
below, going through each one of them. Some functionsare not implemented
in thistutorial, namely the triraise, triSUTActionInformal and
triSUTActionTemplate functionsaswell asall functionswithMC and BC
suffixes that implement multicast and broadcast communication operations.
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16

Openthetestertutorial tri.cfiletolook at the TRI functions. First the
TE->SA functions:

triSAReset

Thisfunction isinvoked in theinitialization phase of the ETS execution,
before any TTCN-3 test code has been executed. In thistutorial it per-
formsthree tasks; it initializes the socket communication, it creates the
protection for the port representation and finally it creates the socket
reader thread.

triExecuteTestcase

Thisfunction isinvoked before each test case is started. In thisimple-
mentation it ensures that port representation structures are cleared.

triEndTestcase

Thisfunctionisinvoked at the end of each test case and usually performs
cleanup actions. In thisimplementation the only thing that isnecessary is
clearing the port representation.

triMap

Each time a map statement is encountered, this function iscalled. It can
alsobecalledimplicitly if you have not specified asystem component for
your test case. Thisis not exemplified in the tutorial, seethe TTCN-3
standard specification for information on this.

In this implementation a new mapping is created and stored in alist of
ports.

triUnmap

The unmap statement isnot used inthe ATSfor thistutorial but thisfunc-
tion is still implemented for symmetry reasons.

In this implementation the mapping is removed from the list of ports.
triSend, triCall, triReply

Thesearethecommunication functionsof TRI. All thesefunctionsworks
in the same way since in TRI, even the synchronous operations of
call/reply are made asynchronous. The synchronous behavior is handled
completely by the RTS.

IBM Rational Systems Tester 3.3 TRI Integration Tutoria April 2010



Integration implementation

triSendMC, triSendBC, triCalIMC, triCalIBC, triReplyMC, triReplyBC,
triRaise, triRaiseM C, triRaiseBC (not implemented)

These functions are not implemented for thistutorial. It is analogous to
the previous functions and can be implemented by the interested user.

Functions with MC and BC suffixes correspond to multicast and broad-
cast versions of communication operations.

triSUTActionlnformal, triSUTA ctionTemplate (not implemented)

These simple functions are not implemented for this tutorial. Their pur-
poseand actionsare completely test suiteand SUT dependent. They have
no meaning in thistutorial.

In-depth look at TRI PA-SA functions

There are two different ways of implementing timers. One is a passive
scheme, where timer statusis polled by the RTS and the other is active,
where timeouts are signaled through the triTimeout function. Theimple-
mentation for thistutorial is the active one since that is the approach sug-
gested by TRI. Toinstruct the ETS to use this scheme, the boolean configu-
rationkey t3rt.timers.assuming all active mMust be set to true.

Then we have the timer related functions

April 2010

triPAReset

Thisfunction is called once, before the control part of the root moduleis
executed. In our case we simply initialize the timer representation.
triStartTimer

Thisiscalled whenever atimer isexplicitly started in the ETS. Note that
implicit timers, like when you specify atimeout value on execute or call
statements, will not trigger this function, it is dealt with in a different
way. See the reference documentation for more details. The design here
isto create a new thread for each new timer and after it has slept for the
appropriate amount of time it generates its own timeout.

triStopTimer

Thisis called when atimer is explicitly stopped by the TTCN-3 code
using the stop statement.

triReadTimer

Thisis called when atimer is explicitly read by the TTCN-3 code using
the read statement.
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triTimerRunning

Thisis called when atimer is explicitly checked by the TTCN-3 code
using the running statement.

tri External Function (not implemented)

Thisis called when an externally declared function is called from the
ETS. No such functions are used in this tutorial so it isleft unimple-
mented.
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Build the ETS

Note
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Goal

In this part you will generate a makefile for the tutorial and build an execut-
abletest suite.

Select configuration

Thistutorial uses configurations to store settings for different platforms and
compilers. Before continuing select the configuration that best matches your
environment either with the project toolbar or with the Pr o ect->Configur a-
tions... dialog.

Prepare makefile generation

The configuration for the makefile generation usually is defined using
“Makefile Options* dialog on “Build* tab in project settings.

Open the Pr oj ect->Settings dialog and bring up the Build tab. Press“ M ake-
file Options...“ button. M akefile Options window opens. As you may see
window has several tabs. Typically you need to use General and Adapter
tabs only.

Open Adapter tab. Check that the “Libraries’ entry control contains:

e t3trionLinux
e t3tri,socket on Solaris
e 1libt3tri.lib,ws2 32.1lib on Windows.

Cfilesthat are put into project are assumed to be adapter files (unless they
are excluded from build) thus there is not need to specify themin “ Source
files* entry control.

Settings in the dialog

Open the Pr oj ect->Settings dialog and bring up the Build tab. In the Root
Module field, write TutorialModule which isthe name of the top module
for thetutorial test suite. Inthe Test management choose “ Static using RTS
functionsin ETS.”
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Compile the test suite

Now push the Compiler button or choose Proj ect->Compiler from the
menu. The code is generated together with a proper makefile
(makefile TRI.mak).|BM Rational Systems Tester automatically setsthe
makefile name in the project settingsto makefile TRI.mak.

Build the ETS

Open the Proj ect->Settings, in the Build tab and ensure that
makefile TRI.mak iSsetfor the Makefilefield.

Press the Build toolbar button or the Project->Build menu entry and the
Compiler invokes the make command on the makefile and the ETS is built.

In your directory you should now have afile named TutorialModule. exe
which isyour finished ETS.
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Run the ETS

Goal

Run the test executabl e including how to set module parameters and to add
your own log mechanism.

Related documentation: “Execution Logs’ (PDF on CD)

The SUT must be started before the ETS is executed. Thisis due to the fact
that it acts asa server form asocket point-of-view and the tutorial ETS needs
to connect to it.

Start the SUT

From command-line, runthe <tutorial dirs>/tutorial sut.exe.
> tutorial sut.exe [-p <portnr>]

The default port number is 30000 and doesn’t have to be changed unlessiit
collides with another process on your machine. If the port number is changed
on the SUT side, it also hasto be modified on the ETS side.

The SUT isrunning properly when it says:

SUT: Tutorial SUT is running.
Start the tutorial ETS.

Execution switch

Thetest is using generated codecs for the ASN.1 types. The SUT uses the
standardized BER encoding and the ETSwill of course need to use the same-
codec. The selection of codec can be controlled through applying a switch.

If the codec is not specified, thetest will end in error due to missing en-
coder/decoder function.
Run ETS from Rational Systems Tester

From the Proj ect menu, select Settings. Go to the Execution tab. Switches
shall be given in the Additional execution switches field under the Execu-
tion tab in the Settings dialog.

Apply the following switch:

April 2010 IBM Rational Systems Tester 3.3 TRI Integration Tutorial 21



Chapter 2: Rational Systems Tester TRI Integration

Note

22

-confbool t3asn.ExtASN.BER.DEFINITE-LENGTH true

All keys passed to RTS should be declared inside -t3rt " command line
parameter key:

-t3rt "-confbool t3asn.ExtASN.BER.DEFINITE-LENGTH true"

Check Assumetimersin TRI areimplemented as “active”. This sets
t3rt.timers.assuming all active key.

Switches can also be supplied in a configuration file specified in the 'Op-
tional configuration file field. For your convenience, thereis a file named
Tester Tutorial.conf in the tutorial directory that contains the appropriate
codec switch.

In the Execution tab ensure that TutorialM odule.exe executable is set for
the Executable test binary field. Select the TesterTutorial.conf configuration
file for the Optional configuration file field. The dialog should look some-
thing like this (here, assuming your directory isc: \tutorial):

TTCH-3 | 451 | Build | Ewecution | Logging | Misc.

Behavior
Default testcase timeout seconds

[ Use builtin codec if nane iz registered for a type
[ Continue template matching o fail
Azzume timers in TR are implemented az "active'

[ Pazs template fomal parameters by value

Module parameters

Optional configuration file

C:MbutorialsTesterTutorial. conf E]
Additional execution switches

-+3rt "-confbool t3asn Exta SN BER.DEFINITE-LEMGTH true"
Executable test binary

C:htutonialhT argetyCAT utonialtd odule. exe E]

Figure 9: Settings for ETS execution
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Now push the Execute button and the test should run. The execution log is
written in the output window of Rational Systems Tester. See the documen-
tation on “Execution Logs’ (PDF on CD).

See also
“ASN.1 Encoding” on page 1346 in Chapter 36, Creating an ETS
“Configuration Files’ on page 1373 in Chapter 38, Execute Tests

Run the ETS from command-line
From the command-line, go to your project directory.

All keys passed to RTS should be declared inside -t3rt " command line
parameter key. Apply the following switches:

-t3rt "-confbool t3asn.ExtASN.BER.DEFINITE-LENGTH true
-confbool t3rt.timers.assuming all active true"

Command line switches can also be supplied in aconfiguration file. For your

convenience, thereis afile named Tester Tutorial.conf in the tutorial direc-
tory that contains the appropriate codec switch, you can useit like this:

> TutorialModule.exe -t3rt "-file TesterTutorial.conf"

The ETS can be invoked with no other special switches unless you have
changed the SUT socket port number. To change port number on ETS side
use“t3rt.tutorial.sut_port <integer keys".For exampleto assign
port #12345 add -t3rt "-confint t3rt.tutorial.sut port 12345"
to ETS command line parameters.

See also

Chapter 38, Execute Testsin IBM Rational Systems Tester help.

Logging

The logging of the test execution is based on log events generated by the
TTCN-3 RTS. New log mechanisms can be plugged in to the RTSto fill the
need for special logging formats and destinations (for example a database).
For information on how to develop alog mechanism, see the “Technical in-
tegration information” documentation (PDF on CD).
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The log mechanism module in thistutorial islogging the events of the test
execution into separate HTML files, one per component. It also generates an
index page over the generated files. Thefilesare al named tut - <hhmmss>-
n.html andtheindex fileisnamed tut - <hhmmss>-index.html (<hhmmss
>= time stamp).

Add the log module

Addthe tut_log.c filefromthe <tutorial dirs directory into your
project inthe Integration Filesfolder. Thiswill automatically add it to thelist
of adapter filesin the generated makefile.

Rebuild and run the ETS again
Redo the following to run the tutorial again:

e “Compilethetest suite” on page 20

e “Buildthe ETS’ on page 20

o “Startthe SUT” on page 21

e “Run ETSfrom Rational Systems Tester” on page 21 or “Run the ETS
from command-line” on page 23

Make sure that any previous SUT or ETS process is terminated.

Module parameters

The main TTCN-3 module (TutorialModule) has a module parameter
called mpar1 declared in the test suite as:

modulepar { integer MParl := 5 };

Thisvalueis used as argument to the Square operation involved in the TCla
test case. To override the default valuefor this parameter, anew value can be
given on the command-line with a switch or through a module parameter
input file. The notation for using adirect switchiis:

>TutorialModule.exe -t3rt "-par Mparl 10"
and notation for module parametersfileis:

>TutorialModule.exe -t3rt "-parfile
tut_parfile.modparams"

Wherethe tut_parfile.modparams should contain the entry:
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MParl := 8;

ETS with different module parameter values

Try thesetwo different ways of overriding the modul e parameter while going

through “Run the ETS’ on page 21 again. Remember that the
TesterTutorial.conf filemust still be given as argument to the ETS.
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In this section some points are made about the implementation of thistutorial
and how it might differ from a more realistic situation.

Separate communication channels

All communication with the tutorial SUT is made using one channel (socket)
only. Thisishow the SUT has been defined, the design with only one socket
is chosen for readability reasons.

In another situation it might be that the SUT uses separate communication
channels for each port. Thiswould mean that the port representation must
keep the channel stored in each port mapping, which isasimple thing toim-
plement. It would also mean that each communication channel needsto be
checked for incoming data, either by having a separate thread for each
channel or having the (equivalent of the) tut socket reader function to
trigger communication on all known channels.

More PTCs

Thereisnolimitation in theimplementation if atest involves multiple PTCs.
The Tc1a test case creates one PTC. This PTC communicates with the SUT
and only when it isfinished, the MTC communicates with the SUT. Two
threads are running but they communicate over the same socket at different
times.

The implementation uses local variables only and uses asingle call to the
socket send function so it is safe.

Timer limitations

Thetimer implementation is not multi-thread safe and has alimitation on the
number of timers. It works currently since the only component that is exe-
cuting any behavior isthe MTC. If multiple components should use timers,
thelist would haveto be protected with amutex and the list would most prob-
ably have to be dynamic in size. Thisis quite straightforward and is left for
the interested reader to implement.
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